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You can download the latest version of X-PRINT from our website (www.aoseed.com/downloads), 
and run the installation wizard.

System Requirements:
· OpenGL 2 compatible graphics card

· Intel Core 2 or AMD Athlon 64 or later

· At least 4GB RAM memory (Recommended: 8GB or above)

· 64-bit

Supported OS: 
Windows

Installation:
After downloading, run the installation wizard to install X-PRINT. When 
X-PRINT is opened for the first time, networked X-MAKER 3D printer will 
be configured automatically. 

Note: X-PRINT only supports X-MAKER 3D printer currently. More printers will be added later.

Download



X-PRINT is a professional 3D slicing software, which can meet the need of model data processing for 3D 
printing. Users can load files into X-PRINT, adjust models based on their needs, configure slice settings for 
the model and view the slicing model, so as to obtain the optimal printing results.

X-PRINT Workflow 

Load file Adjust model Configure slice 
settings Slice Print
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Interface overview

1 Menu bar: Contains file, edit, view, settings, help, and 
more options.

2  Model toolbar: Contains operations like load, copy, 
layout, by face, and delete.

3 Connected printer: Displays the selected printer.

4 Slice button: Quickly slices the model and outputs the 
file that can be printed directly.

5 3D Viewer: Views the model after being loaded 
successfully.

6 Adjustment tools: Move, rotate, and scale. 

UI elements of X-PRINT
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Common operations

Layout

Delete

Connect Slice

Rotate

Copy
Place all models in optimized 
position automatically

Rotate the model in 
anyway you like

Load
Load single or multiple models

Copy the selected 
model

Go to configure slice settings

Delete the selected model
By Face
Click on any face of 3D 
model to align to baseplate

Add the 3D printers

Move
Move the model along 
its X, Y, and Z axes

Scale
Scale the model size
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Open 3D files
You can load 3D models or sliced models of various file types in the following ways.

Save sliced files
You can save sliced model files in the following ways.

1. Go to X-PRINT menu and click 'File > Import' in the top left corner of the interface. The file browser of your operating system opens. 
Select the 3D model you would like to load.
2. Click and drag the 3D model you would like to load on the X-PRINT main interface.
3. Click the 'Load' button from the X-PRINT toolbar on the left-side of the interface. When the file browser opens, select the 3D model 
you would like to load and click 'open'.

1. When slicing is finished, click the second button above the 3D viewer. The file browser of your operating system opens 
and save the file locally.
2. After you have sliced your model, go to 'File > Save as...' to save the file.

Supported File Types in X-PRINT
· 3D model files (Support viewing and adjusting): XSTL file (.xstl), STL file (.stl), Wavefront OBJ File (.obj), 3D Studio File (.3ds)
· Sliced model files: (Only support viewing):  X-code file (.xcode),G-code file (.gcode)

Files can be saved as, X-code file (.xcode) , G-code file (.gcode) and PNG Image (.png). (PNG Image 
can't be uploaded or printed.)
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Mouse actions

View

Left mouse button
1. Select the model by left clicking it. (The color of selected models will be brighter.)
2. Press and hold the left mouse button while moving your mouse to rotate your view 
of the model.
3. Deselect the model by left clicking on a blank space.

Scroll wheel
1. Use the scroll wheel for zooming in and out.
2. Press the scroll wheel to move the 3D viewer.

Right mouse button
1. Select the model by right clicking it. (The color of selected models will be brighter.)
2. Press and hold the right mouse button while moving your mouse to rotate your view of 
the model.
3. Deselect the model by right clicking on a blank space.

Click the 'View' button from the menu bar and change different view of the model. (Default, top, bottom, front, 
back, left and right.)
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Model adjustments

Scale: Select the model you would like to scale and click the second tool in the right-side toolbar to scale the models. You can set the 
exact model size in millimeters, or set a multiple of the original model size. You can also drag the scale handles to scale the model. 
Tick [Scale] to ensure the model's proportions are consistent while scaling. Tick [Apply to All] to scale all models uniformly.
Click [Maximum size] to scale the model to maximum printable size. Click [Reset] to return the model to its original size.

Rotate: Select the model you would like to rotate and click the third tool in the right-side toolbar to rotate the model. You can rotate 
the model by setting the exact rotate degrees or dragging rotate hoops around the model. You can also click each [90 degree] button 
to rotate the model by 90 degree along each axis.
Click [Reset] to reset all rotations of the selected model.

X-PRINT can help users adjust and place the model to obtain the optimal printing results.

07

Move: Select the model you would like to move to open the adjustment tools on the right. Click the first tool to move the model in 
the ways you like:  Set exact coordinates of the 3D model; Drag arrow handles to move the model along its X, Y, and Z axes; Left-click 
and drag the model to move along its X and Y axes.
Click [Place on baseplate] to make the model adhere to the baseplate. Click [Center] to place the model in the center. Click [Reset] 
to reset all moving modifications to the selected model.
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Select the model and click the [Copy] button in the left side toolbar to open Copy Settings panel. Enter the number you want to 
copy and click the [OK] button.

Copy

Click the [Layout] button in the left side toolbar and all models will be automatically placed in optimized position to ensure better 
printing results.

Layout

Select the [By Face] button in the left side toolbar. You can click on any face of the 3D model to automatically align this face to the 
baseplate.

By Face

Undo / Redo
Go to X-PRINT menu and click 'Edit > Undo/Redo' to do these operations. The shortcut for 'Undo' is 'ctrl+Z'. The shortcut for 
'Redo' is 'ctrl+Y'. 

Select the model you would like to delete and click the [Delete] button in the left side toolbar to delete the model, or go to X-PRINT 
menu and click 'Edit > Delete'. To quickly delete the model, select the model and press 'Del'.

Delete
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Model adjustment
The following principles are recommended to ensure the optimal printing results.

Support structures are generated below the overhanging parts to prevent 
these parts from falling down in the process of printing, which need to be 
removed after printing. It is necessary to reduce or avoid the support structure 
for less scarring of the model.

Less support structures

Center the model
Place the models as centered as possible.

Reduce the clearance of models
When printing multiple models, large clearance between them may lead to 
increased print time.
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After adjusting the models, you can adjust the slice settings. In X-PRINT there are two modes available in the slice settings 
panel: 'Advanced Slice Settings' and 'Expert Slice Settings'. Generally, 'Advanced Slice Settings' is often used.

Click the [Slice] button above the 3D viewer to open the Slice Settings panel.

Recommended Slice settings

Printer: X-PRINT only supports X-MAKER 3D printer 
currently. More printers will be added later.

Filament: X-MAKER 3D printer is compatible with most 
PLA/ABS filaments.

Profile: It contains various printing profiles. The number 
represents the layer height and 'Fine/Standard/Fast' 
represents the print speed. You can directly use the 
recommended slice settings.
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You can use 'Recommended Slice Settings' directly and click [OK] to slice the model, or you can make parameter settings using 
'Advanced Slice Settings'.

Expert profile
Click [Expert Profile] button and you can make more 
professional settings. It is recommended to use Default 
Profile in expert slice settings. Improper parameter 
settings might result in unsuccessful printing results.

Save print profiles
When slice settings are complete, you can click 
[Save As New] button to save the profile for later use.
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Parameter settings
Layer Height: It is the thickness of one printed layer in millimeters. A thinner layer height produces a higher resolution, 
leading to a smoother surface of the model. Similarly, thicker layer heights lead to a rougher surface.

Wall thickness: It is the thickness of the model's outer wall. A thicker outer wall will create a sturdier model.

Infill density: In order to decrease the print time and filament costs, the inside of the print will be printed as a grid-like pattern. A 
higher infill density means that there is more plastic on the inside of your print. 0% infill prints a completely hollow model. A 100% 
infill prints a completely solid model.

fine rough

solidhollow
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There are three options to place the support structure for the models: everywhere, touching build plate, or none.
None: This option is suitable for models with big bottom and small top, such as cylindrical, conical and cubic models, as well as 
models with simple structure or gentle slope angle.
Touching build plate: If the overhanging parts float mid-air and there's no model below it, support material will be printed under 
these parts. This option is suitable for models that have internal cavities, such as whistles and clarinets.
Everywhere: Support material is printed below every part that needs support.

None touching build plate everywhere

Print speed: It is the speed (in mm/s) at which the nozzle moves while printing. A higher print speed will lead to a shorter print time, 
while a poorer print quality.

model with support structure model without support structure

13

Support type: Some models have overhanging parts. In this case, you must print a support structure under the model to prevent these 
parts from falling down. Support structures can be removed after printing.

Infill speed: It is the speed at which the infill material is printed.

Travel speed: It is the speed at which the nozzle moves when it's not extruding.

Slice settings



Support pattern: There are eight patterns available for printing support structures: zig zag, lines, grid, triangles, concentric, 
cross, gyroid and tree. Zig-zag and lines are commonly used, which are easier to remove.

Critical angle: If the overhang angle passes the critical point, support material needs to be added.

Zig Zag Lines Grid Triangles Concentric Cross

Gyroid Tree
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an overhang angle of 45 ° an overhang angle of 60 ° an overhang angle of 70 °
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Adhesion type: Different baseplate adhesion types can help the model better adhere to the baseplate and prevent the model from 
sliding during the printing process. There are four types of baseplate adhesion: none, skirt, brim and raft. All these can be removed 
after printing.

None: If you set it to None, remember to calibrate the distance between the model and the baseplate.
Skirt: A skirt is a line printed around the model on the first layer, but not connected to the model. This helps adjust the extrusion nozzle 
and detect any possible problems before the print begins, so as to reduce the waste of time and materials caused by failed 3D printing.
Brim: Brim adds a single layer flat area around the base of the model. The brim is connected to the model and makes the bottom 
surface area bigger. This can increase the adhesion to the baseplate but it is difficult to remove.
Raft: A raft adds some layers between the model and the baseplate before printing the object. A raft ensures that the model will stick 
better to the build plate and improve the stability.

Note: The default adhesion type is 'Raft'.

Raft Brim Skirt
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After configuring the slicing settings, click the [Slice] button above the 3D viewer and an X-code file will be 
generated. During the slicing process, you can view the slicing progress in the status box below. You can 
also click the [Cancel] button above to stop the slicing.

When slicing is complete, you will see the layer view of sliced model. You can view the needed time and 
filament for the print job in the Slice Result panel. Drag the slider below to view the internal layer details of 
the sliced model. (Check whether the support and adhesion type are added correctly.)
Above the 3D viewer, there are three buttons: [Model View], [Save] and [Print]. Click [Save] button to save 
the file locally. Files can be saved as G-code / X-code format. Click [Print] button to upload the file to 
X-MAKER printer and print directly.

Slicing data processing Slicing completed Layer view

16

Slice



Connection

One-press printing

Set up Wi-Fi
· You can connect your printer and computer to a wireless network. Please ensure your printer and computer/tablet are 
connected to the same WLAN, so as to upload the file to printer successfully.
· You can also set up network connection via hotspot on the printer if there is no WLAN available.

IP Connection
· If Wi-Fi connection doesn't work, you can also set up IP connection to print the model by navigating to 'Setting-About' using 
touchscreen.

U-disk connection
· With offline printers, you can save the files into the U-disk for printing.

One X-MAKER 3D printer can only set up one connection. If the printer is running the print job, please wait for 
the disconnection and set up new connection again.

After successfully connect X-PRINT to X-MAKER 3D printer, click [Print] button to upload the file to printer and print directly.
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Go to X-PRINT menu and click 'Settings' button, then you can set printer, filament and slice parameters, as 
well as switch the language.

Printer Settings
X-PRINT only supports X-MAKER 3D printer currently.

Filament Settings
Name: compatible with PLA and ABS filaments

Diameter: the diameter of the filament

Nozzle temperature: the nozzle temperature used for printing

Bed temperature: the bed temperature used for printing

Flow: the amount of extruded material outflows from the nozzle

Description: notes for filaments

Slice Settings
Adjust slicing parameters of various models for optimal print results.

Language Settings
Languages supported by X-PRINT: English and Chinese. After changing the language, please restart X-PRINT.
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Initial layer: This defines the height of the first layer of your 
print. A thicker initial layer creates better adhesion to the 
baseplate.

Lind width: It is the width of a single printed line, which 
should correspond to the width of the nozzle. 

Infill to set infill density, infill pattern, top and 
bottom layers, etc.
Infill pattern: Various patterns of the printed infill structure are
available. Grid pattern is most common used.

Infill overlap: The amount of overlap between the infill and the 
walls as a percentage of the infill line width. This can be set to 
make the infill firmly connect to the walls.

Top layers: The number of top layers. A higher value ensures 
all gaps on the top layers are closed completely.

Bottom layers: The number of bottom layers. A higher value ensures all gaps on the bottom layers are closed completely.

Infill before walls: With this setting enabled, infill will be printed before the walls, which leads to sturdier walls but worse 
overhangs.

Expert slice settings - General
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Height settings to set layer height, line width, 
initial layer and wall line count

Expert profile



Expert slice settings - General

Model fixes to fix errors in models when generating the print files
Union overlapping volumes: If a model contains two volumes that interfere, this setting will recognize these interferences and 
print the volumes as one. This may cause internal cavities to disappear.

Remove all holes: Remove unnecessary holes on the inside and keep only the outside shape. This will ignore any invisible 
internal geometry.

Keep disconnected faces: Models contain small holes that cannot be stitched, which may lead to poor print results. This setting 
can connect all neighbouring geometry to close the model.Remove empty first layers: Remove empty layers beneath the first 
printed layer if they are present.

Extensive stitching: This setting can stitch up open holes in the mesh by closing the hole with touching polygons, but it may bring 
a lot of processing time.

Optimize wall printing order: This can optimize the order in which the walls are printed so as to reduce the number of retrac-
tions, while extra print time will cost.

Skin overlap: Adjust the amount of overlap between the walls, as a percentage of the average line width between the skin 
lines and the innermost wall lines.

Merged meshes overlap: Create an overlap where merged models meet. This makes two parts bond together better.
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Expert slice settings - Adhesion

Parameters for Raft
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Raft margin: This is the extra raft area around the model. 
Increasing this margin will create a stronger raft.

Raft gap: The gap between the final raft layer and the first layer of the 
model. You can raise this amount to peel off the raft easier,

Raft top layers: The number of top layers on top of the 2nd raft layer.

Initial layer Z overlap: The amount of overlap between the first 
and second layer of the model. Increase this amount can compress 
the initial layer against the raft.

Base thickness: Layer thickness of the base raft layer.

Base line width: Width of the lines in the base raft layer.

Base line spacing: The distance between lines for the base raft layer.

Base print speed: The speed at which the base raft layer is printed.

Middle thickness: Layer thickness of the middle raft layer.

Middle line width: Width of the lines in the middle raft layer.

Middle spacing: The distance between the raft lines for the middle raft layer.

Middle print speed: The speed at which the middle raft layer is printed.

Top layer thickness: Layer thickness of the top raft layers.

Top line width: Width of the lines in the top surface of the raft.

Top spacing: The distance between the raft lines for the top raft layers.

Top print speed: The speed at which the top raft layers are printed.

Expert profile



Expert slice settings - Adhesion

Parameters for Raft
Skirt line: The number of skirt lines printed around the model.

Skirt gap: The distance between the model and the skirt.

Skirt / Brim minimum length: The minimum length of the skirt or brim. If the length is not reached yet, more skirt or brim lines will be 
added until the minimum length is reached.

Parameters for Brim
Brim line: The number of lines used for a brim.

Brim only on outside: Only print the brim on the outside of the model.

Skirt / Brim speed: The speed at which the skirt or brim lines are printed.
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Cooling settings to adjust the fan speed and cooling time

Support speed: The speed at which the support structure is printed, 
as a percentage of print speed.
Initial layer speed: The speed for the initial layer, as a percentage of 
print speed.
Bottom speed: The speed at which bottom layers are printed, as a 
percentage of print speed.
Outer wall speed: The speed at which the outer walls are printed, as 
a percentage of print speed. 
Inner wall speed: The speed at which the inner walls are printed, as 
a percentage of print speed.

Enable print cooling: With this setting you can enable the nozzle fans during printing.
Lift head: Allow the nozzle to move away from the print during printing for better print quality.
Minimum speed: The minimum print speed.
Initial fan speed: The fan speed on the initial layer only, which then changes back to the regular fan speed.
Maximum fan speed: The percentage of maximum fan speed.
Minimum layer time: The minimum time spent in a layer. If a layer takes less time than the set value, the printer slows down.
Regular fan speed: The percentage of regular fan speed.
Regular fan speed layer: The layer at which the fans spin on regular fan speed.

Expert slice settings - Speed

Speed settings to set various speed parameters for print 
jobs. Based on the print speed, other speeds are percent-
ages of print speed.
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Expert slice settings - Support

Support settings to adjust the support placement, 
overhang angle and other parameters

Extruder: With muti-extrusion printers, you can specify whichparts of 
the support are printed with which extruder.

Pattern: The pattern of the support structures of the print. Zig-zag 
pattern is sufficient for most print.

Density: The density of support structures. A higher value will lead to 
stronger support.Line width: Width of the outer walls of the support.

Minimum support area: Minimum area size for support.

Limit support retractions: Enable this setting may lead to excessive 
stringing within the support structure.

Connect support lines: Connect the ends of the support lines together 
to make the support more sturdy.

Top distance: Distance from the top of the support to the print.

Bottom distance: Distance from the print to the bottom of the support.

X/Y Distance: Distance of the support structure from the print in the X/Y directions.

Wall line count: The number of walls that are printed around the support pattern.

Tree wall line count: The number of walls of the tree support.
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Expert slice settings - Support

Support floor settings to set parameters of the interface of the support where it touches with the 
model on the bottom
Layers: The thickness of the support floors.

Speed: The speed at which the support floors are printed, as a percentage of print speed.

Line distance: Distance between the printed support floor lines.

Support roof settings to set parameters of the interface of the support where it touches with the model 
on the top

Layers: The thickness of the support roofs.

Speed: The speed at which the support roofs are printed, as a percentage of print speed.

Line distance: Distance between the printed support roof lines.

25

Expert profile



Expert slice settings - Extruder
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Nozzle settings to set the diameter and printing 
temperature of the nozzle

Filament: PLA and ABS filaments are compatible with X-MAKER 3D 
printer. The parameter settings will change according to various filaments.

Diameter: The diameter of nozzle.

Printing temperature: The nozzle temperature used for printing.

Retraction to adjust parameters to avoid stringing

Retraction speed: The speed at which the filament is retracted during 
a retraction move. Retraction defines that the filament will be retracted 
when the nozzle is moving over a non-printed area. This can avoid 
extruded material due to gravity and get a much cleaner model. 

Retraction distance: The length of material retracted during a retraction move.

Z hop height: Whenever a retraction is done, the nozzle is raised to create clearance between the nozzle and the print. It 
prevents the nozzle from hitting the print during travel moves.

Minimum travel: The minimum distance of travel needed for a retraction. This helps to get fewer retractions in a small area.

Minimum Extrusion distance: The minimum extrusion length for a retraction.

Extra prime amount: This is the extra amount of material that is extruded after a retraction to compensate for 
oozed material after a travel move. 

Expert profile
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Coasting settings Coasting replaces the last part of an 
extrusion path by a travel move. The oozed material is used 
to print the last piece of the extrusion path in order to 
reduce stringing.
Enable coasting: Switch on coasting mode.

Minimum volume before coasting: The minimum volume an
extrusion path should have before allowing coasting.

Coasting volume: The volume of material that is coasted.

Combing settings Combing keeps the nozzle within the 
perimeter of the print when travelling. This results in a 
reduced need for material retraction.
Combing: The area needing combing.
Max comb distance: The maximum comb distance, longer thanwhich retraction will be used.

Special modes to optimize and adjust the printing process
Smooth spiralized contours: This setting can reduce the visibility of the Z seam, but it will tend to blur fine surface details. This mode 
is usually off.
Spiralize outer contour: This setting smooths out the Z move of the outer edge. This will create a steady Z increase over the whole 
print, which is usually off.
Print one at a time: In this mode, objects will be printed one by one. Note that all models are separated so that the nozzle can 
move in between without damaging the print.

Expert profile
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Small feature to adjust the parameters of smaller features on the model for better adhesion and accuracy

Max length：Feature outlines that are shorter than this length.
Speed: Small features will be printed at this percentage of their normal print speed.
First layer speed: The speed at which small features on the first layer are printed. This is a percentage of normal print speed.

Initial layer settings to set parameters for the initial layer

Line width: The width of lines on the initial layer.
Flow: The amount of material extruded on the initial layer.
Temperature offset: The increase of the nozzle temperature used for printing the initial layer.

Expert profile
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Other support settings
Break up support in chunks: This setting divides zig-zag pattern 
support into separate structures by adding small gaps. This allows 
support structures to be easily pulled away piece by piece.
Support chunk line count: Skip one in every N connection lines to 
make the support structure easier to break away.
Use support tower: Use towers to support tiny overhang areas.
Tower diameter: The diameter of a special tower.

Size compensation settings
Horizontal expansion: By adjusting the X/Y size of the model, you 
can compensate for the tolerance of the print.

Z seam settings
Z seam alignment: This setting allows you to choose where each new layer in the Z direction starts. When paths in consecutive 
layers start at the same point, a vertical seam can be visible. When using specified, the start point of each layer will be aligned near
 a user specified location. When placed randomly, the next layer starts at a random point of the previous layer. Shortest is the 
fastest way of printing.
Seam corner preference: Control whether corners on the model outline influence the position of the seam. None means that that 
corners have no influence on the seam position. Hide Seam makes the seam more likely to appear on an inside corner. Expose 
Seam makes the seam more likely to appear on an outside corner. Hide or Expose Seam makes the seam more likely to appear at 
an inside or outside corner. Smart Hiding allows both inside and outside corners, which will be adjusted automatically.

Expert profile
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Ironing settings
Enable ironing: When the nozzle travels over the top-most layer one additional time, it will extrude very little material. 
This is meant to melt the plastic on top surface, creating a smoother surface.
Iron only highest layer: Apply ironing only to the very last printed layer.
Ironing line spacing: The distance between the lines of ironing.
Ironing flow: This percentage of material is extruded on top of the last layer while ironing.

Expert profile



Follow us on:

Software: X-PRINT
Product Name: X-MAKER 3D printer
Product Type: V4.0
Manufacturer: Aowei (Shanghai) Digital Technology Co., Ltd.
Contact: +86-21-60719032
Address:  No. 16, Lane 2999, Hutai Road, Baoshan, Shanghai, China
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